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Congratulations on your adoption of i>clicker, the easiest-to-use classroom response system available. 
This guide will enable you to quickly start using i>clicker’s fundamental functions, as well as learn to use 
its more advanced features.

•	 The upgrade to i>clicker 5.5 is not required. You may continue to use your current version of i>clicker 
if you prefer not to upgrade. You may also continue to download i>clicker 5.4 from the Downloads 
page at www.iclicker.com.

•	 The upgrade impacts both the Windows and Macintosh operating systems.

•	 For i>clicker 5.3 and earlier users, the upgrade will not affect the data in your older MyCourseMac 
folders. However, you will need to follow the steps in the Converting from i>clicker 5.3 section if you 
would like to use the new software with your older data.

For more specific information about i>clicker 5.5, you may wish to consult the Software Upgrade 
Conversion Guide via the Support > User Guides page at www.iclicker.com.

Want to learn more about i>clicker software through live training? Visit us at http://iclicker.webex.com 
to sign up for a training session where we review the software in its entirety. Or email us at 
sales@iclicker.com to schedule a session.

Have a specific technical question and need help? Email us at support@iclicker.com or call us toll-free at 
866.209.5698.
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1 Getting Started

Overview
Using i>clicker to poll your class can significantly change the way you and your students interact by 
enabling you to assess your students’ knowledge, keep their attention, provide immediate feedback, 
and encourage all students to participate. An audience response system can also be used in conference 
settings to poll the audience on the content of your choice.

The i>clicker software for Macintosh is completely packaged in a single folder. This folder contains the 
i>clicker application for polling, the i>grader application for assigning credit to students, and the Web 
Update utility for checking for software updates.

System Requirements
Before starting, make sure that your computer system meets or exceeds the following i>clicker system 
requirements.

•	 Mac OS X version 10.4.21 or higher (including OS 10.5 and OS 10.6)

•	 500MHz G4 (or faster) processor

•	 256MB RAM (or larger) recommended

•	 one available USB port

•	 Minimum screen resolution of 1024 x 768 pixels

In addition to these computer requirements, a projection system is highly recommended for 
presentation purposes.

1 If you are using Mac OS 10.4 but do not have 10.4.2 or higher, check for free Mac OSX updates by running the OSX Software Update utility. Be sure 
that the option to install 10.4.2 (or higher) is checked in the Software Update list and click the Install button.
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Obtaining the i>clicker Software
Don’t have the i>clicker software yet? You may download the latest i>clicker software free of charge 
from the i>clicker web site.

To get i>clicker from the web:

1 Go to the i>clicker website at www.iclicker.com.

2 In the top navigation, select Downloads and click Instructor.

3 In the Instructor Downloads section under i>clicker 5.5, click Macintosh.

4 The i>clicker software will be downloaded to your hard drive. Navigate to the location on your hard 
drive to which the file was saved and locate the i>clicker Mac folder. No additional installation is 
needed. (Optional) You may now copy the i>clicker Mac folder to a flash drive or network drive.

Setting Up i>clicker
i>clicker is a plug-and-play system that requires no installation and minimal set-up for both the 
hardware and software. The i>clicker software is provided on a flash drive included in the i>clicker 
instructor kit. If you did not receive the flash drive, see Obtaining the i>clicker Software above.

To set up your computer and folder structure:

1 Connect the i>clicker receiver base to your computer through the USB port. The LCD screen on the 
receiver will light up, signaling that your computer is powering it. 

IMPORTANT: To be sure that the receiver has sufficient power, plug the receiver directly into the computer and do 
not connect through the keyboard or a non-powered USB hub. 

2 If you are running i>clicker from a flash drive, connect the i>clicker flash drive to the USB port on the 
back of the i>clicker receiver base.

3 Double-click the flash drive icon that appears on your desktop. The i>clicker flash drive contains two 
folders: iclicker Win and i>clicker Mac. These folders contain the software for PC and Mac users 
respectively.

NOTE: We recommend you double-click the WebUpdate icon the first time you use i>clicker. 
WebUpdate will walk you through the steps to ensure you are using the latest version of 
i>clicker. The latest software can also be downloaded free of charge from www.iclicker.com.

Running the i>clicker software from a flash drive is not requred. The benefit of using the flash drive 
is that the i>clicker software is fully portable – just insert the flash drive into any computer to access 
i>clicker and your course folders. You may also copy and paste the i>clicker Mac folder to use i>clicker 
from any location, such as a network or computer hard drive. However, you will need to have easy 
access to the i>clicker Mac folder location during your lectures. In order to track your class’s voting 
data, you must be able to access the same i>clicker folder from this location every time you start polling 
in class.
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Creating Your Courses in i>clicker

IMPORTANT:  For i>clicker 5.3 and earlier users, it is no longer necessary to make a separate copy of 
the MyCourseMac folder for each i>clicker class or section. A single copy of the new i>clicker Mac 
folder now gives you access to all your courses and sections.

1 Double-click the i>clicker icon to start the program.

2 The Welcome screen appears with no courses listed. Click Add Course.

3 An Add Course window appears. Enter your Course Name, Course Number, and Section Number. 
This combined information will serve as the unique identifier for your course.

4 Click Create. i>clicker automatically creates a new course folder in your i>clicker Mac:Classes folder. 
The Add Course window closes and you are returned to the Welcome screen where you will see your 
course name in the list of courses.

5 Repeat steps 2–4 to create as many courses or sections as you need.

i>clicker
icon
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Converting from Earlier Versions of i>clicker
With i>clicker 5.4 and 5.5, you no longer have to make a separate copy of the MyCourseMac folders for 
each course/section in which you are using i>clicker. Because of the changes to the folder structure, the 
steps to upgrade your software are a little different from previous versions.

To use i>clicker 5.5 with i>clicker 5.3 and earlier course data, take the following steps:

1 Locate the MyCourseMac folders that contain your older course data (You may have changed the name 
of the folder to match your course title).Copy and paste (or drag‐and‐drop) your MyCourseMac folders 
into the Classes folder within your new i>clicker Mac folder. (If you have more than one i>clicker 
course, copy the folders for each of your courses into the Classes folder.)

2 Within the i>clicker Mac folder, double‐click the i>clicker icon. Your older course folders will appear in 
the new Welcome screen. Select your course and click Choose.
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2 Polling Your Students in Class

Polling Students
1 Double-click the i>clicker icon to start the program.

2 The Welcome screen will appear. Select the desired course from the list of available courses and click 
Choose. If you do not see your course listed, see the previous section Creating Your Courses in i>clicker.

3 The Main Menu screen will appear. Click start session in the center of the screen.

The Main Menu will disappear and you will see the floating toolbar appear in the top left corner of 
your computer desktop, indicating that polling is active.

You can reposition the toolbar anywhere on your desktop. The floating toolbar allows you to run 
i>clicker with your presentation application(s). For example, if you use PowerPoint or Keynote, both your 
presentation and the i>clicker toolbar will be active (see example below). The toolbar floats above any 
application including Word, Acrobat, Web browsers, Mathematica, etc.
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TIP FOR KEYNOTE USERS: In order for the i>clicker menu bar to float over your presentation, be sure 
Keynote is set to allow other programs to share the screen. In the Keynote Preferences menu, please 
select the option below:

TIP: If you reposition the toolbar on your desktop, the system will remember its placement and retain 
the new location until you change it again. This feature gives you more flexibility and control to 
design your lecture presentations so that the floating toolbar never obstructs your question text or 
images.

4 When you are ready to pose a question, advise your students to turn on their clickers. Then present the 
question and answer choices (either verbally or visually) and click START on the toolbar.

NOTE: i>clicker will only begin collecting votes after you click START. If you do not click START, 
i>clicker will not accept or record any votes. A green Vote Status light on the students’ remotes 
indicates that a response has been successfully recorded.

TIP:  If you use a program to display your question (e.g., Keynote), make sure it is the active 
application when you start polling. Each time you click START to begin polling, i>clicker captures an 
image of the active window and stores it along with polling results for later review in i>grader.

5 Click DISPLAY on the toolbar to view a graph of your students’ responses for the current question. (See 
Viewing Student Responses below.) To end the polling session, click STOP on the toolbar and i>clicker will 
no longer accept votes. The toolbar will display the word “Done” along with the total number of votes 
collected for five seconds after polling has ended. After five seconds, the counter and timer will 
disappear so the floating toolbar is less obtrusive.
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NOTE: i>clicker stops collecting votes when you click STOP. If students attempt to vote when polling 
is not active, the Vote Status light on their remotes will flash red three times to indicate that a 
response was not received.

6 Repeat steps 5 and 6 for each question you ask in class.

NOTE: Students can turn on their i>clicker remotes and vote at any time while polling is active by 
pressing the ON/OFF button on the remote. We recommend students keep their remotes on during 
the lecture. This is particularly important if a frequency other than the default AA is in use. For more 
information regarding frequency, see page 30. The remotes will automatically shut off after 90 
minutes of inactivity to save battery power.

Viewing Student Responses
1 Clicking DISPLAY on the toolbar will show a graph of your students’ responses for the current question. 

The graph displays the percentage of total votes and number of votes for each answer choice.

The histogram colors have been redesigned using Color Universal Design, a design system developed 
in consideration of people with various types of color vision, to allow information to be accurately 
conveyed to as many individuals as possible.

TIP: You may also display two graphs, the current graph and any previous graph, side-by-side 
by clicking on the Compare Graphs link in the graph window. The second graph will display 
underneath your current graph. You may select the Previous or Next arrows to toggle between 
graphs in choosing your second graph to display.

2 To designate a correct answer, roll your mouse over the graph so that the correct answer choice buttons 
appear. Click the letter that corresponds to the correct answer. When you select a correct answer, the bar 
colors will change. The bar for the correct answer will become green, while all others become red.

3 To clear the correct answer selection and return to the default graph, roll your mouse over the graph so 
the answer choice buttons appear and then click the ? button.
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TIP: When you designate a correct answer on the response graph, it is saved into i>grader. If you have 
chosen to award students points for correct answers, all points will be adjusted accordingly. If you 
select a correct answer on the graph and then click ? to clear the selection and return to the default 
graph mode, the correct answer is also deleted from i>grader and no points adjustments will occur.

5 To display data for the previous question, click the Previous (<) arrow. To display data for the next 
question, click the Next (>) arrow.

6 To stop displaying the graph, click HIDE.

TIP: You can also display or hide the student response graph by pressing the B button on the 
instructor’s remote. You can designate a correct answer by cycling through the choices with the E 
button on the instructor’s remote.

Your receiver’s LCD screen also displays voting results and is updated every second when polling is 
active. Information on the screen includes the timer (upper left), the total vote count (upper right), and 
the percentage distribution of votes across the five answer choices (bottom). The LCD screen is a useful 
tool to monitor student voting progress and choices without displaying the graph to the whole class.

A    Timer
B    Number of responses received
C    Percentage of total votes for responses A-E

Floating Toolbar Options
The floating toolbar contains buttons for three key functions: START/STOP polling, DISPLAY/HIDE and 
access to the Options menu . Click the  arrow button to access the Options pull-down menu and 
reveal the following options:

Loan/Register Clickers Manually register an individual clicker, permanently or for just one session, or 
initiate In-Class/Roll-Call registration. For more information on in-class and manual 
registration options, see page 12 of this Guide.

Question On the Fly Ask a spontaneous question and have it recorded as a screen capture without closing 
out of your presentation application.

Settings and Preferences Access the program settings and preferences directly from i>clicker. For more 
information about these options, see pages 28-34 of this Guide. 

Anonymous Polling Ask a question and collect polling results without associating any student 
information with the responses. This type of question is particulary useful for polling 
students on sensitive topics where they may not want their names or student IDs 
associated with their answers.
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Asking Questions On The Fly

By selecting Question On the Fly, you can ask a question spontaneously and have it recorded in a 
screen capture, without closing out of your presentation application. For example, you could be using 
Keynote in slide show mode, decide to ask an unplanned question mid-lecture, and ask it using the On 
the Fly option without ever having to exit or close your Keynote slide show. 

To use this feature, click the arrow menu button from the floating toolbar and select the Question On 
The Fly option. From the dialog window that appears, type in a question title in the Question Title field, 
your question in the Question field, and if so desired, the “correct” answer in the Answer field. Select 
START from either the floating menu bar or using your instructor’s remote. 

A screenshot will be taken when polling begins and will be saved in i>grader, along with the question 
title and the correct answer (if you chose to designate one). Hit the Close button at the bottom of the 
textbox to close the question.

Anonymous Polling

Anonymous polling questions are ideal for allowing students to answer sensitive questions without 
worrying that you will link their responses to their student IDs later. When you poll students 
anonymously, their answers are not associated with their student names or IDs in the course roster. 
Student responses to questions that have been designated as anonymous polling questions are 
recorded with an “X” in the i>clicker log files. For example, by using anonymous polling, you will have no 
way of knowing that John Doe selected A in response to the question “Who did you vote for in the last 
Presidential election?” The answers to the question are completely anonymous.

To select an anonymous polling question, click the arrow menu button from the floating toolbar and 
select the Anonymous Question option. An (*) appears next to the START button on the i>clicker 
toolbar, indicating that the question is anonymous. Click the START button to begin polling and STOP 
to end polling.

You will not be able to see individual student voting data for anonymous polling questions in the 
i>grader reports. Anonymous polling data will, however, be included in the cumulative results within 
i>grader (e.g., 50% of students voted A, 25% of students voted B, 25% of students voted C). Students’ 
individual responses to anonymous questions will be marked as Ap in the student summary reports 
within i>grader.

NOTE: You can assign participation/attendance points to anonymous polling questions; however, 
you cannot assign performance points because there are no correct answers for anonymous polling 
questions.

Exiting i>clicker
When your class is over, simply click on the small square (the quit button) at the top right corner of the 
menu bar to quit the i>clicker application. You will be asked if you really want to quit i>clicker and, if so, 
click on Yes. Each student’s response to each question will be saved in the class folder on your flash or 
hard drive.

Resuming Your Last Session 
In addition to the option to start a new session, there is also the option to Resume Last Session from 
the Main Menu screen. Choosing this option allows you to resume a lecture rather than starting a new 
one. This option is especially useful if you accidentally exit the i>clicker application or have a computer 
crash.
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3 Registering Your Students’ Remotes

The i>clicker system may be used as a simple tool to give you instant, anonymous feedback in class, in 
which case no registration procedure is necessary. However, if you (like most instructors) want to go a 
bit further and give credit to your students for class participation and/or performance, you will need to: 

1 Associate each of your students with the unique serial number on their i>clicker remotes (i.e. 
Registration). 

2 Decide on the grading details for each session of your class (see Assigning Credit for Sessions and 
Questions). 

TIP: Research studies show (Caldwell, J.E. “Clickers in the large classroom: Current research and 
best-practice tips.” Life Sciences Education, 6(1), 9-20, 2007.) that students participate and vote 
using clickers more consistently when clicker points are worth at at least 10% of their overall grade. 
When clickers are worth 5% or less of the total course grade, students take voting less seriously and 
participate less frequently.

IMPORTANT: DO NOT use the following instructions for registering students if you are using i>clicker 
with a course management system (e.g., Blackboard). Go to www.iclicker.com and download the 
instructions for your specific CMS. i>clicker currently supports Blackboard, Blackboard CE/Vista 
(WebCT), Moodle, ANGEL, Sakai, and Desire2Learn.

Creating Your Student Roster File
Each student remote has a unique serial number printed on the back. This number is referred to as the 
remote ID.

Associating or registering a student with the remote ID is required before a student can receive 
individual credit for voting in class. To register your students, you must first create a file containing 
student information in your course folder. If you are not planning to integrate voting data with your 
CMS system, you will create a text file named Roster.txt.

NOTE: Students can still vote with their i>clicker remotes before registering but until they’ve 
registered their remotes, their votes will be linked within i>grader to only the i>clicker remote ID. 
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The roster file must have one line for each student in your class, with each line containing the student’s 
Last Name, First Name, and Student ID, separated by commas. The Student ID may be a college ID 
number, email alias, or any other easily readable text string—as long as it is guaranteed to be unique for 
each student. We recommend that you use an ID number or naming convention that you currently use 
(personally or as required by your institution) to record your students’ other grades, for easiest import of 
i>grader data into your course grade book. 

Roster.txt File

The TextEdit application (or any other plain text editor) can be used to easily create your roster file.

To create a TXT file using TextEdit:

1 Go to the Applications folder and open TextEdit.

2 Add the student information for each student in your class either by typing or copy and pasting it from 
an existing roster (in Excel or any other format) into TextEdit.

3 Save the roster file as Roster.txt. the file must be saved in your course folder (within the Classes folder 
in your i>clicker Mac folder).

You will need to follow the steps above for each section or course in which you are using i>clicker. An 
example Roster.txt file (shown below) is provided in your course folder. You may wish to simply edit this 
file rather than creating a new one. 

TIP: If you have your course roster in Excel or Numbers format, you can avoid re-typing your entire 
roster. Make sure the columns in your roster follow the format in the example above (last name, 
first name, student ID) and that there is only one student per row. Then save the document as a .csv 
file, name it Roster.csv, and save it to your i>clicker Mac:Classes:[course name] folder. Open your 
i>clicker Mac:Classes:[course name] folder. Delete or rename the Roster.txt file. Then rename the 
Roster.csv file to Roster.txt. Open the file and spot-check it to make sure it is formatted correctly.

To import a course roster from your course management system (CMS):

Refer to the user guide for your specific CMS, which is located in the Support > User Guides section of 
www.iclicker.com. Following the instructions provided for your specific CMS, save the CMS roster to your 
i>clicker Mac:Classes:[course name] folder.

Registration Options
i>clicker offers you three straightforward registration options: a web option that can be done outside 
of class, an in-class option for your entire class, and a manual option for individual students. Minimal 
information is required of your students and all registration options are tied to your class roster. There 
are no site license or registration fees for i>clicker software.

TIP: In-class and online registration are not mutually exclusive, and both can be used to register 
students in one class.
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Web Registration (Option 1) 

Online registration is recommended, especially for classes of fifty students or more. To register online, 
send your students to www.iclicker.com and have them click the Register Your i>clicker button.

TIP: The key to successful web registration is deciding what student ID will be used and sharing those 
directions with students before they register their clickers online. Consider including instructions 
in your syllabus that describe and/or give examples of the student ID so your students follow the 
proper registration protocol. 

To complete the student registration form, students must :

1 Enter their First Name and Last Name in the appropriate fields.

2 Enter their student ID. This student ID must match the one that is in your Roster.txt file or your CMS 
roster file.

3 Enter their i>clicker remote ID. The remote ID is the 8-character alphanumeric code printed below the 
barcode on the back of their remote.

4 Enter the letters or numbers in the captcha security image on the screen. This verification image is a 
slightly distorted series of characters used to prevent spam bots from submitting the form.

5 Click the Enter button. An on-screen message confirms that registration was successful. The student’s ID 
is now tied to their unique i>clicker remote ID.

After your students have registered online, you need to synchronize i>grader to update the information 
in your class folder. Refer to Synchronizing Web Registrations on page 16.

NOTE: If a student has not voted with their i>clicker remote, the online registration will not 
synchronize with your i>grader application. The student must vote at least once in class. We 
recommend that you ask at least one clicker question, such as an attendance or ice-breaker question, 
on the first day of class in order to capture remote IDs before requiring your students to register.

TIP: Students can use a single i>clicker remote for multiple classes and only need to register on the 
web once. If a student makes a registration mistake they can simply register a second time. 



13i>clicker User Guide   Macintosh

In-Class/Roll Call Registration (Option 2)

This registration option is only recommended for small classes with fewer than 50 students. The two 
registration options (Web and Roll Call) can also be used in combination.

To use Roll Call, your computer screen needs to be projected so that all students can see it.

1 Launch i>clicker and click start session.

2 Click the options button  on the floating toolbar and select Loan/Register Clickers from the menu.

Click the Roll Call button in the displayed window. The Roll Call screen will appear with a scrolling list of 
names from the class roster file.

3 When names scroll into the central blue area, letters appear in the first column of boxes. Instruct 
students to press the letter on their i>clicker that corresponds to the letter next to their name. Once 
they’ve entered the first letter, a new letter appears in the second column. They must also enter that 
letter to confirm the registration.

The following options are available in the roll call registration screen:

1 You can control the speed at which your students’ names scroll down the screen with the Scrolling 
Speed option in the top right hand corner. 

2 The instructions for students are outlined on the screen and are easy to follow.

3 You can modify the information that appears about your students on the screen. Choose to display 
Student names only, Student IDs only, or both. For more on this feature, see page 30. 

NOTE: If students’ names scroll off the screen before they are able to complete the registration, they 
must wait for their names to reappear as the list loops around. Names will continue to scroll on the 
screen in a continuous loop until either all students have registered or you click the Close button at 
the bottom of the screen.
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TIP: Students accidentally registering their clicker to the wrong name should press the D button on 
their i>clicker remote twice to clear the incorrect registration and restart the registration process.

In-Class “Individual” Registration (Option 3)

If only a few students need to register, an individual registration option is available. This registration 
process is typically used when new students join your class after you’ve already completed Roll 
Call registration. Because this option is limited to registering a single student at a time, it is not 
recommended for registering a large number of students.

1 From the i>clicker floating toolbar, click on the down arrow to open the Options menu and select Loan/
Register Clickers. Be sure that For the Term (Permanent) is selected from the Register drop down 
menu 

2 Now enter the student’s Remote ID, the eight-character code on the back of their i>clicker. This can be 
done by just typing it into the Remote field, or by having the student hold the On/Off button on the 
remote until the blue light starts flashing (around two seconds) and pushing the A button twice. This 
will send the clicker ID to the computer and the Remote ID will appear in the Remote field as if you had 
typed it. 

3 Select the student’s ID from the drop down menu labeled Student. The names in this list are taken from 
your Roster.txt file. Click OK. The student’s ID will be associated with the corresponding i>clicker remote 
ID. 

This registration process assigns the remote to the student for the duration of the course. In the 

example, Remote ID 0028E7CF is permanently assigned to Jane Smith with ID jsmith.
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Loaning a Clicker 
If students forget their i>clicker remote, you can loan one for a single lecture. To associate the loaned 
clicker with a student for one lecture only, you should perform a temporary or loaner registration. 

To do this, follow the exact same steps as outlined above for an individual registration, but make sure to 
select the For one Session (Loan) option from the Register drop-down menu. 

If this option is used, the assignment of the i>clicker remote ID is tied to that student for one lecture 
only. This temporarily overrides any permanent registration. The student will receive credit for any 
votes during that lecture and these will be synchronized with existing scores. In subsequent classes, the 
student can resume using his/her regular clicker. 
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4 Using i>grader to Assign Credit for Sessions 
and Questions

TIP: Remember to check for software updates to i>clicker and i>grader using the
WebUpdate tool.

1 Before launching i>grader, always make sure to exit the i>clicker application. Then open the i>clicker 
Mac folder on your flash drive or computer, and double-click the i>grader icon.

2 The i>grader application will start and you will see a screen similar to this one: 

A list of students will display in the left-most column, and a list of your voting sessions will display across 
the top row. You will see all students as listed in your Roster.txt file (or other gradebook file if you have 
chosen to use i>clicker with your course management system). You may view the students by StudentID 
or by last name, using the drop-down menu directly above the column of students. 

Registered students will appear in blue, and unregistered student names or IDs will appear in red. The 
recorded votes of your students who have not yet registered are stored under their i>clicker remote ID. 
These numbers appear in red at the end of the student list. 

By default, each Lecture column is labeled by polling session date. If you conduct two polling sessions 
on the same day, those two sessions will be shown separately on the main i>grader screen. The example 
screen above indicates that clickers were used in two lectures (on September 8, 2009 and on September 
23, 2009). Of the student names appearing on the screen, three have registered their clickers (Sample 
Student 1, Sample Student 2, and Sample Student 3) while the other three have not. The remote serial 
ID (#1CFA7B9D) at the bottom of the list belongs to an unregistered student who have participated in 
voting sessions.

TIP: If you choose Resume Last Session from the Main Menu screen, your additional polling data will 
be included in the previous session, thereby eliminating separate entries in i>grader.

i>grader 
Icon
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Synchronizing Web Registrations 
Once your students have completed the registration form and you have held at least one i>clicker 
session, you may update your course registration information using the Synchronize Web 
Registrations feature.

NOTE: You will must be connected to the Internet to synchronize web registrations.

To synchronize web registrations:

1 Click Synchronize Web Registrations from the main i>grader window. 

2 A Synchronize Web Registrations window will appear with a description of the synchronization function. 
Click Continue to proceed. 

3 i>grader synchronizes your roster information with your students’ online registrations. After 
synchronization is complete, click Done to return to the main i>grader window.

If an inconsistency between your roster and the web registrations exist, you will be prompted to resolve 
it before synchronization is completed. The software will alert you to any discrepancies between your 
roster and the web registrations. Your choices for resolving registration conflicts include:

•	 Ignore: no registration information is associated for that particular student. 

•	 Accept: allows the student ID to be included in i>grader and associates the student with the correct 
remote ID.

•	 Cancel: exits the registration process and leave i>grader unchanged. 

Example: A student registers his i>clicker online, entering remote ID 143B436C and student ID 67-890. 
Upon synchronizing, you are notified that this student’s student ID does not match any record in your 
roster file. You realize that the student has both mistyped his last name and entered the student ID in a 
slightly different format from the student ID in your roster file (with a dash in the middle). Because you 
can be reasonably sure that this is the correct student, you select his name from the list of students in 
the roster and click the Accept button. This action associates the correct student ID 67890 with i>clicker 
remote ID 2796B1. 
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TIP: Students can register multiple times without affecting the synchronization process. If you are 
unsure if a web registration matches the student’s roster, you can always ignore the registration, ask 
your student to register online again, and run another web synchronization process at a later time.

Any unregistered clicker IDs that remain after this step (i.e., you continue to see records with red clicker 
ID numbers), likely belong to students who have not yet registered online. Check with your students 
and synchronize again later. If there are problems synchronizing only one or two students who have 
registered online, you can also run a Roll Call registration or register these students manually. You can 
repeat these steps as often as necessary.

TIP: We suggest setting a deadline, no matter how loose or long, for web registration. An end date 
will allow you to confirm all students are registered and assist you with classroom and i>clicker 
management.

Managing Unregistered Clicker and Student Data 
i>grader contains tools that allow you to search and delete batches of unregistered clicker records and 
generate reports of unregistered students and unregistered clickers. To access these tools, click the 
eyeglasses icon in the header of the first column.

You will see the following window appear. You will have the option to toggle between two screens: 
View and Select Unregistered Clickers and View and Export Unregistered Students. 
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The View and Select Unregistered Clickers screen details votes from clickers that have not been 
registered to any student in your roster. You may see votes from unregistered clickers if students have 
not yet registered successfully, if students accidentally brought a friend or roommate’s i>clicker remote 
to class with them, or if students voted in only a few sessions and then dropped the class.

TIP: If you have a very large class or if your class deadline for registration has not yet passed, you 
may have a large number of unregistered clickers in i>grader. To help you manage your course 
information, use the Advanced Settings option to filter the results list.

The Advanced Settings search allows you to select unregistered remote IDs meeting specific criteria.

For example, let’s say that several students voted only once or twice before dropping your class, and 
never registered. You can use the Advanced Settings options to search for unregistered remotes with 
averages or total points in a very low range (such as between 0 and 10 total points). When you click 
Select, the Advanced Settings window will disappear and all remotes matching your criteria will have a 
check in the Select column to the right of the ID number.  

To use another example, a student may email you and tell you that the remote ID number on the back of 
his i>clicker remote has partially rubbed off and as a result he can’t complete the web registration. You 
can search for the remote ID using the Remote ID containing filter and find it in your records. 

The View and Export Unregistered Students tool allows you to compile a list of students who have 
not yet registered.

From this screen, you have the option to export the list of unregistered students in two formats: comma-
separated (.csv) or text (.txt). Choosing either of these options will create a file named Unregistered 
Student List in your course folder.

NOTE: While you can create two separate files using this tool, exporting the same type of file more 
than once will overwrite your data. For example, if you have previously exported this list to CSV, then 
clicking Export to CSV again will overwrite the existing file, but clicking Export to Text will not.
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i>grader Functions 
From the main screen of i>grader, you can edit student registrations as well as session and scoring 
information. 

Editing a Student 

This feature allows you to modify which remote IDs are associated with a particular student ID.  

1 Locate and click on the student ID or name. You will see the pop-up dialog shown below. 

2 To remove the association of a particular clicker to that student, highlight the clicker remote ID in the 
pop up, and then click Remove. (This will remove the student/remote ID association, but the remote ID 
and its data, will stay in i>grader.) 

3 To associate a new remote ID with this student, click Add. You will see an additional pop up window 
to add a new remote ID. Enter the new remote ID and click OK. The ID will then appear in the list of 
Registered Clickers tied to that student. Highlight the new clicker ID and click Add.

4 Click Save and then OK on the final confirmation message.
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Setting Session Scores 

To assign credit and establish the points for any given polling session, locate the session and click on the 
session title. That session’s information will appear and be available for editing.

This screen allows you to delete and modify question data and award Participation/Attendance Points 
and Performance Points for this lecture. 

In the example shown above, detailed information is displayed for a question in the session held on 
5/6/2008. The Session Summary on the top part of the screen gives the course name, date and time 
of the session, and indicates that five students participated and six questions were asked during the 
lecture. From here, you also have the ability to edit your Session Name. There is a 10-character limit on 
session names.

If questions are deleted from the session, the Number of Questions value will change, but you can still 
view the deleted questions by using the Previous/Next controls on the bottom right of the screen 
(below the thumbnail image). The Deleted questions will be marked as deleted on the thumbnail image, 
and the Delete this question box will be checked.

Participation/Attendance Points are used to credit students for attending class and for participating in 
the voting activities. Students only needs to place a vote for at least the minimum number of questions 
to receive participation points. They do not have to answer the questions correctly. These points are 
awarded by session, not by question—the student either answers the minimum number of questions 
and receives all participation points, or does not and receives zero participation points.

NOTE: Students can receive participation points for Anonymous Polling questions. Anonymous 
Polling questions do not, however, have a correct answer and therefore cannot be used for 
Performance Points.

In the Settings and Preferences area of the i>clicker program you can set a participation requirement 
by percentage of questions answered. The minimum number of responses will be automatically 
calculated for you. From the Set Scores screen shown here, you can modify the minimum number 
of questions your students must answer in order to receive participation points. You also determine 
the total number of participation points possible for that session. The minimum number of questions 
required will be adjusted each time you delete and restore questions from your session. 

TIP: We strongly encourage you to utilize the participation/attendance feature which is designed to 
promote student engagement and teacher-student interaction.



22i>clicker User Guide   Macintosh

Performance Points are awarded to students by question for specific answers. Many professors use 
performance points to reward “correct” answers. Performance points (if any) are assigned to each 
question individually. If you have already set a point value for correct answers in i>clicker Settings and 
Preferences, you may simply designate the correct answer in the Performance Points area and that 
answer choice will automatically be awarded the correct number of points. You may also assign credit 
or partial credit for multiple answers by manually adding point values in any of the five boxes above the 
answer choices (A, B, C, D, E).

Since you may not remember the details of each question you asked in lecture, i>clicker takes a screen 
capture for you every time you begin a question by clicking START on the floating menu bar. To view 
this image in i>grader, click on View Screenshot next to the question title field. The button changes to 
Hide Screenshot and can be clicked again to return to the Set Scores screen. The screen shot function 
allows you to ask on-the-fly questions easily by providing you with an automatic record of your lecture 
questions. 

To scroll through the questions, click on Previous or Next. Once you have assigned points values for 
each question, use the Set and Close button in the bottom right corner. All points allocations will be 
saved and you will return to the main i>grader window, where you will see your overall session scores 
have been adjusted.

Notice that i>grader has updated the summary for this lecture and the column of averages. As more 
sessions are recorded, the columns to the right of the one labeled 9/23/09 will be populated, and you 
will be able to assign grades for these sessions as well. 

You are able to change the grading assignments/point values for any session at any time. 

Deleting a Question 

To delete a question, open the Set Scores screen for the session that contains the questions you wish to 
delete. Use the Previous and Next arrows to open the question, then select the Yes option for “Delete 
this Question?” under the question title. The question will no longer be calculated in your participation 
requirements and student scores for the session. It will remain visible in the Set Scores screen. At any 
time, you may restore the deleted question by returning to the session, finding the question in this 
screen, and changing the “Delete this Question?” option to No.
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Reporting
The Run/Update HTML Reports feature creates summary information in an easily readable and 
printable format. Clicking the Run/Update HMTL Reports button generates the reports listed below:

Term/Session Summary and Review report provides a breakdown of polling data, both for your term 
to date and for individual sessions. No individual student scores or votes are included in this report, 
making it ideal to share with your class as a post-lecture study guide. The linked Summary Review 
reports contain individual question statistics, the screenshots taken when you began polling (which 
should contain each individual question), and the voting results graphs for each session. 

The Student Voting Data report contains grades for your individual students, by session and by 
question. Cumulative Student Scores provides you with a review of each student’s performance for 
each i>clicker session. 

The reports can be opened and printed using any web browser. They can also be posted to a course web 
site or course management system (We recommend using Adobe Acrobat to post the reports, but you 
can also post as HTML files/pages with a little bit of work). 

The Term/Session Summary and Review report and the Student Voting Data report are both placed 
directly in your course folder within the i>clicker Mac:Classes folder. You may access and open them 
from that location at any time. All other reports (Summary and Question Data for single sessions, and 
Student Score reports) are linked from one of these two reports or accessible from the Reports folder 
within your course folder.

TIP: You can update reports as often as you need – the old reports are simply over-written with your 
most recent data. Your Term/Session Summary Review report will contain general information about 
each session as shown below.
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To view more detailed session information, click Session Summary and Question Data for any session, 
to display the Session Summary report. The Session Summary data is displayed at the top of this report, 
followed by information about individual questions. Scroll down, or click a question title to jump to the 
question information. 

Click your Course Title to return to the Term Summary report.  

For each individual question you may review a screen capture of the question, voting results graph, and 
the number of students who selected each answer.

TIP: The Session Summary reports are ideal to share with your students after class.

Your Student Voting Data report is similar to the Term Summary Report, only instead of links to 
individual Session Summary reports, you will now see links to a detailed report of student responses for 
each session. At the top of this report will be a link to View Cumulative Student Scores. These Student 
Reports provide you with an easily printable overview of your student’s entire performance with 
i>clicker, and are particularly helpful for struggling students. 

Before creating your HTML reports, the system will ask you what student information you’d like to 
include in the Student Reports. You may include your students’ last name, first name, student ID in any 
combination. (You may also choose to generate a report showing remote IDs only. This report is ideal 
for displaying student results while maintaining student privacy.) Your customizations will affect how 
individual student data will be displayed in the Student Voting Data and Cumulative Student Score 
Reports.
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The Cumulative Student Scores link will bring you to the Student Term Report. Note that the student 
data displayed here includes: 

•	 Student last name, first name, student ID 
•	 Their total number of points for the term 
•	 Their point average 
•	 The number of points received for each individual polling session 

To view your students responses click on the session title/date at the top of the column and you will 
quickly receive a complete review of each student’s activity during the session. 

If you have designated a correct`answer for any of the questions, it will appear in this report in green 
and incorrect answers will appear in red. If you did not designate a correct answer, the voting choices 
will appear in black.

The table shown below lists each student’s answer to each question. Clicking the Question titles in this 
report will show you the relevant information from the Session Summary and Question Data report 
described above. 
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TIP: Clicking on any of the Session Titles will bring you to the same report as the Student Reponses 
link for that session in the Student Data report.

Exporting Grade Data 
You can export student grade data as CSV files. CSV (comma separated value) is a simple file type that 
can be read by nearly all text editors, spreadsheet, and database programs, including Microsoft Excel. 
You can choose to export the file in a simple General format or in a format that is ready to upload into 
your course management system. The General format is discussed below. For details on specific course 
management systems, please see the related documentation available at www.iclicker.com. 

There are two i>grader buttons available for exporting grades:  Export a Selected Session as CSV 
(Excel file) and Export all Sessions as CSV (Excel file).

Export Selected Sessions

This function allows you to select specific sessions to export. In the above example, Lecture 1 has been 
selected by checking the box to the left of that session’s name. You may select one session or multiple 
sessions. 

When you click the Export Selected Session(s) button, you will be asked what data you would like to 
export. You may export any combination of the following data (provided that the data is availabe):

Student Data: First Name, Last Name, and Student ID.

Session Data: Performance Points, Participation Points, and Total Points for each individual session. The 
total session points includes the performance and participation points for each session.

NOTE: This option is only available when you are using i>clicker with the General/Non-CMS setting. 
If you are exporting i>clicker data in a format specific to your campus CMS, you will only be able 
to export the total points for each individual session and the aggregate points for all or selected 
sessions. 

Aggregate Data: The combined Performance Points, Participation Points, and Total Points for all of your 
selected sessions.
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After you’ve selected the data you’d like to export, you will receive a message that your students’ scoring 
data has been saved into your course folder located in the i>clicker Mac:Classes folder. The name 
of the file will vary depending on whether or not you are formatting your data for a particular course 
management system. The default file name, however, is UploadFile.csv. 

The default UploadFile.csv file will include the data that you select for export. Below is a sample file, 
opened with Microsoft Excel.

NOTE: Your file may be saved/named slightly differently if you are using i>clicker with your campus 
course management system (and have followed the steps required to enable i>clicker files to be 
formatted for your particular course management system). 

TIP: Each time a file is exported, the same filename (UploadFile.csv) is used. This will overwrite any 
existing files of the same name from previous exports. If you wish to keep more than one file, simply 
rename the first one something different, or move the file out of your course folder, before using the 
Export option again. This will avoid the second report overwriting the first.

Export All Sessions

This option also creates a file named UploadFile.csv, in the course folder.  

While similar to the Session Report, the Term Summary Report includes session and aggregate data for 
every session you have held to date. See Export Selected Session for a more information on exporting 
session data. 

NOTE: Please see the course management documentation available via the User Guides page at 
www.iclicker.com for detailed instructions on integrating i>clicker and i>grader with your course 
management system.
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5 Customizing i>clicker and i>grader

You can use the Settings and Preferences options to customize i>clicker and i>grader. Select Your 
Settings and Preferences from the i>clicker Main Menu screen to change the Settings and Preferences.

The default settings for both the i>clicker and i>grader applications are chosen to make this classroom 
response system the easiest to learn and quickly use. 

However, you may alter the defaults to best meet your individual needs.  

TIP: You have the option to save your preferences for the current polling session or the entire term.

In addition to the Main Menu screen, the Settings and Preferences screen is also available from the 
i>clicker floating toolbar.

To access the Settings and Preferences from the i>clicker toolbar, click on the Options button  then 
select Settings and Preferences from the drop-down menu. 

The Settings and Preferences window has been re-organized to make it easier to located and change 
your preferences. The window is still organized into four tabs: General, Registration/Export, Question 
and Polling, and Scoring. Below is an overview of each subsection for each tab in Your Settings and 
Preferences. 
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General Settings/Preferences

Course Name: The course name field shows the course name that you entered when you created your 
course. You can change your course name by editing the text in the course name field.

NOTE: Editing the course name in General Preferences only affects the course name that appears 
in i>grader, on the Main Menu screen, and on your reports. To change the course name on the 
Welcome screen you must edit the course folder name in i>clicker Mac:Classes.

Instructor’s Remote ID: You may designate one remote as the Instructor’s Remote for your own use in 
class. The Instructor’s Remote controls polling and moves between slides in your presentation software, 
allowing you freedom to move around the room while conducting i>clicker polling sessions. Rather 
than counting the five choices (A, B, C, D, E,) as student votes, the buttons control key functions of the 
i>clicker polling software.

To activate the Instructor’s Remote, enter the clicker’s serial ID (located on the bottom of the back of 
your i>clicker) in the Designated Instructor’s Remote field in General Settings and Preferences. If 
you plan to use the Instructor’s Remote regularly, we recommend you set the code for the entire course 
(or term).

TIP: Many teachers use the blue remote as their Instructor’s Remote. There are no technical 
differences between a blue Instructor’s Remote and a white student remote. The color is designed to 
make it easier for you to keep track of your individual and loaner remotes.

TIP: To use the C and D functions on the Instructor’s Remote, your presentation software must be the 
“active” application on your Mac. i>clicker will still float above your presentation software. However, 
if i>clicker becomes the “active” program, once on your presentation program screen to make it the 
active application again and enable the C and D buttons on the Instructor’s Remote.
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Toolbar: This option allows you to choose the size of the floating toolbar that will sit on top of your 
presentation materials. The default size of the floating toolbar is small as it is the least obtrusive/
distracting when projected on screen. However, if you have a very large lecture hall (auditorium), the 
larger toolbar projects the timer and vote count more easily.

Frequency Code: The i>clicker 2-way radio frequency student response system operates on one of 16 
channels in the 915 MHz frequency range. 

The default frequency channel for both the base and the student remotes is AA. If you are the only 
professor using i>clicker at a given time you should not modify this frequency. However, if someone else 
is using i>clicker in close proximity, one of you will want to use a different channel (such as AD, as in the 
example below). i>clicker has sixteen different frequencies available (AA, AB, AC, AD, BA, BB, BC, BD, CA, 
CB, CC, CD, DA, DB, DC, and DD).

TIP: If you know you will be using i>clicker near another professor using i>clicker for the term, we 
recommend you set your default frequency for the entire term. If i>clicker is in use across your 
institution, you may also need to coordinate frequencies with your IT administrator. They may have 
already assigned channels to each classroom.

If you change your frequency from the default, your students will need to change their remote 
frequency at the beginning of each session. When you begin polling, an alert will appear with 
instructions for your students.

To change their remote frequencies, ask students to:

1 Press and hold the On/Off (power) button on their i>clicker until the blue Power light begins flashing. 

2 Press the two-letter code (that you’ve designated in your Settings/Preferences). In the example below, 
that new code is AD. A green Vote Status light will indicate your students have successfully reset their 
remote frequency.

This remote frequency will be set for as long as the remote is on. Students will need to repeat this 
procedure for every session or each time they turn on the remote..

Freqency Code Alert Message: You may alter the length of time that the frequency code alert warning 
appears on your screen, or you may choose to disable the warning/change alert completely (so that it 
never displays). 

If you prefer that the warning remain on screen until you click the Close button at the lower right, 
choose the option to Close Manually. If you do not want to see the warning pop up before each 
question in the session (but do want the alert to appear the first time you ask a question), wait for the 
pop up to appear and then un-check the option Warn again on next question below the instructions. 

NOTE: The receiver must be plugged in and the i>clicker application must be running to enable 
students to perform this procedure. 
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Registration and Export Settings and Preferences 

In-Class (Roll Call) Registration: This setting modifies the way that student names appear on the Roll 
Call screen for in class registration. This option does not modify the format of your roster or grade book 
file. For more information about the Roll Call feature please see page 13 of this guide.

Web Registration: The security code is only needed if your students are registering via a locally hosted 
web site that is specifically for your institution. In this case, you will be given a security code by your 
campus IT staff. If you are interested in local registration contact support@iclicker.com. 

Course Management System: If you plan to record i>clicker grades in your school’s course 
management system, select the system here. This will modify the format of the exported CSV files from 
i>grader so that they can be imported into your CMS. If you are not planning to integrate i>clicker with 
a course management system, leave the default option None (General) selected. 

i>clicker includes support for Blackboard (including Blackboard 9.1), Blackboard Enterprise (WebCT) CE 
and Vista, ANGEL (including ANGEL 7.4), Moodle, Sakai, and Desire2Learn. For additional help with CMS 
integration, contact support@iclicker.com. 

If you are using i>clicker with your CMS, please follow the directions located in the course management 
system documentation (available on www.iclicker.com) to ensure your registration data is consistent 
with your course management system. 

Polling Session Settings and Preferences 

Question Information: This option asks if you would like a pop- up window to appear before each 
question. If you select Yes, a pop-up window will appear each time you initiate a question in i>clicker, 
allowing you to title the question and assign a correct answer. The correct answer will not display in the 
Answer field; your students will only see an asterisk (*) regardless of the letter choice you enter. 

TIP: You may pre-assign titles and correct answers to your questions. For instructions, please 
see page 37. To pre-assign question titles and answers, you MUST choose the Show question 
information before each question radio button.
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Polling Timer: When you start polling (i.e., when you click START), the software automatically launches 
a timer. The default i>clicker timer counts upwards, beginning with zero. In the default setting, you must 
select STOP to end polling. 

Through Settings/Preferences, you may choose instead to define a countdown time, choosing any 
length of time in 15 seconds increments from 15 second up to 4 minutes. The timer will automatically 
stop at zero and end the polling period. 

TIP: In the countdown mode, the + and - buttons to the left of the timer allow you to add or subtract 
20 seconds as needed. You can still stop polling by pressing STOP on the floating menu bar.

Response Grid: This option allows you to display (or hide) a grid of your students’ voting entries each 
time you ask a question. The voting results grid gives students an additional opportunity to confirm 
their votes were received. (Note that the Vote Status light on each remote flashes green each time 
a vote is received by the i>clicker base, so your students can confirm that their votes were recorded 
without displaying this grid.)

TIP: While this is a comfort to students, the voting results grid can be distracting if used extensively. 
You can minimize the voting results grid during a polling session by clicking on the top right corner 
of the grid. 

There are two ways to display the voting results grid. Confirm response was received only allows 
students to see their vote was received but doesn’t indicate their choice, while Confirm response was 
received and show response choice allows students to see both their vote receipt and last received 
response on the screen.

In order for an ID to appear, the student must have responded successfully to at least one question in 
the session. The first time the voting grid displays in a polling session, all of the remote ID responses 
will be either blue or green. (The student’s first response is colored blue, the second is colored green, 
and any subsequent responses to that same question toggle between these colors.) For subsequent 
questions in the same lecture, however, the grid will initially display all remote IDs that have been used 
in the session, in white. When those remotes have voted in response to the question, the color will 
change to blue. If they do not vote during a particular question, the remote IDs will remain on screen 
but stay white.

NOTE: To help students find their responses, their IDs will be in the exact same location for that 
lecture only.  

Confirmed Receipt and Vote Selection displays both the student’s i>clicker remote ID and a different 
color depending on their last received response. As in the example below, a key will appear at the top 
of the grid to let you know which colors correspond to which answer choices. The student with remote 
ID 02671277 answered B for this question, while students with remotes 0268CAA0 and 005EFCA2 
answered C. 
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TIP: During polling, your students can freely change their votes at any time until you select STOP 
(their last vote is recorded). Students may use the color coding in this Vote Selection grid to quickly 
identify the most popular answer and change their vote in response. This behavior could both skew 
your question data and also impact your performance points assignments. If you are assigning 
performance points for a correct answer in your sessions, you may not want to choose the Confirm 
response was received and show response choice option.

Results: During polling, a graph displays the results of each question in your session. The graphs 
can be displayed by clicking the Display button on the i>clicker floating menu bar or using B on the 
Instructor’s Remote. This setting allows you to select whether the graph should be displayed as multi-
color, monochrome, or a pie chart.

Scoring Settings and Preferences 
In this section, you are able to establish the point values earned for actively participating in class and for 
answering questions correctly.

Participation (Session-Based) Points

Participation points are awarded to students who attend and vote during lecture (encouraging student 
engagement). Participation points are awarded by overall session activity, not by individual question. 

Session Participation Points: This field allows you to enter the number of points students earn in 
any given session for meeting the participation requirement, as defined in the Requirement to Earn 
Participation Points below.

Requirement to Earn Participation Points: To earn the point value established above, students must 
respond to a certain percentage of questions in a session. 

Depending upon the total number of questions, i>clicker will automatically calculate the minimum 
number of responses needed. 

Example: If you enter 10 points in Session Participation Points and there are 10 questions in a session, a 
student must respond to 9 of the 10 questions if the Students must respond to all but one question 
radio button is selected.
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Performance (Question-Based) Points 

Performance points are awarded to students by question for specific answers. Students can earn 
performance points without earning participation points, depending on your preference.

Points for Responding This option allows you to enter the default number of points students are awarded 
for any answer. These are different from participation points in that they reward 
students for performance by question, whereas participation points reward 
students for participation by session. 

Points for Correct 
Response

This field allows you to reward students for choosing the correct answer for each 
question and are earned in addition to any performance points you award in for 
simply answering the question.

Total Performance Points Here, you can cap the number of total performance points a student can earn in a 
single session. Example: If your maximum is capped at five points, and you hold a 6 
question session with each question worth one point, even if a student answers all 
6 questions correctly, the most she can earn for that session is 5 points.

You may choose to set these preferences for the entire term or just the current session. Your selections 
on the Scoring Options settings will appear in the i>grader Set Session Scoring window for 
subsequent lecture(s).
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6 Resuming Your Last Session

In addition to Your Settings and Preferences on the Main Menu screen, there is also the option to 
Resume Last Session. This allows you to resume a lecture, rather than starting a new one. This option is 
useful if you accidentally exited the i>clicker application or had a computer crash.
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7 Updating the Software

From time to time there will be improvements made to the i>clicker and i>grader programs. These 
updated versions can be downloaded free of charge using the WebUpdate application that you can 
find in the i>clicker Mac folder.

Double-click on the WebUpdate icon in your i>clicker Mac folder, making sure the computer you 
are using has access to the internet. The WebUpdate application checks the i>clicker website for the 
version numbers of the latest available i>clicker and i>grader applications and compares these to the 
ones in your current i>clicker folder. If either or both of your applications are not the most recent, you 
will be given information about the newer version(s) and the opportunity to update.

IMPORTANT:  It is strongly recommended that you not use WebUpdate to upgrade from i>clicker 5.3 
and earlier to i>clicker 5.5. When upgrading to i>clicker 5.5, please download the latest version from 
the Downloads page at www.iclicker.com and refer to the Conversion Guide for instructions on 
upgrading. Once i>clicker 5.5 is downloaded, you can begin using WebUpdate to update i>clicker. 
This is necessary because the folder structure changed from version 5.3 to version 5.5 of the software. 
The 5.3 folder structure cannot be updated using WebUpdate.

You will be asked about i>clicker and i>grader separately. Click on the Install Updates button to update 
your software.

WebUpdate 
Icon
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8 Pre-Assigning Question Titles and Answers

If you’d like to assign titles to your questions and/or the correct answer before your lecture (instead of 
the default Q1, Q2 assignments given by i>clicker), you may create a question list file and save it in your 
course folder. If you are teaching multiple sections or courses, you will need to include a questionlist.
csv file in each course folder.

Formatting the Questionlist File
The file must be in the format “question title, answer” with one question on each line, as shown in the 
example below. In this example, the questions are titled “Question 1,” “Question 2,” and “Question 3,” and 
the correct answers are “A,” “E,” and “B” respectively.

Question 1,A 
Question 2,E 
Question 3,B

The question list can be created using any application that generates a CSV-formatted file. The most 
commonly used programs for this purpose are Microsoft Excel and TextEdit. No matter what program 
you choose to create the question list, you must also:

•	 Save the file within the i>clicker Mac:Classes folder so the software is able to locate and apply the 
values you defined into i>grader. 

•	 In the i>clicker Setting and Preferences select the Show question information before each 
question radio button from the Polling Session tab.

Creating a questionlist file in Microsoft Excel 

1 Launch Microsoft Excel. 

2 In column A, enter the title of each question. 

3 In column B, enter the corresponding correct answer. 

4 Go to File > Save As... and name your document questionlist in the Save As field.

5 Click the Where: drop-down menu and select your course folder (e.g., i>clicker 
Mac:Classes:PSYCH-400-001).
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6 In the Format drop-down menu select Comma Separated Values (.csv). The file extension .csv is 
added to your filename.

IMPORTANT: Make sure that your filename does not include two .csv extension (e.g., questionlist.csv.
csv). This file format will not work properly with your i>clicker application. 

7 Click Save.

Creating a questionlist file in TextEdit 

1 Open the TextEdit application located in your Applications folder.

2 Enter the title of your question followed by a comma and then the correct answer. Do not add a space 
between the comma and the correct answer.

3 Select File > Save As... and name the file questionlist.csv.

4 In the Format drop-down menu select Unicode (UTF-8) as the file format. (If the Unicode option is not 
available, cancel the Save and go to the Format menu. Select the option Make Plain Text.)

5 You will be prompted with a warning message saying “You have used the extension “.csv” at the end of 
the name. The standard extension is “.rtf” (or “.txt”). Click Use .csv.

TIP: Because of the ease-of-use, we recommend using the TextEdit option.

Maintaining Multiple Question List Files
i>clicker can only identify and utilize one questionlist.csv file at a time but you may decide to maintain 
multiple question lists. For example, you may wish to create separate question lists for each lecture or 
you may want to save multiple question lists for future use. To keep multiple question lists, create the 
files using unique, descriptive file names such as questionlist0716.csv or Chap 4 Biodiversity.csv and 
save them outside of your i>clicker folder. When you are ready to use a specific question list for your 
lecture, copy the file to your i>clicker Mac:Classes folder and rename it questionlist.csv. When you are 
finished with the lecture you can delete the copy in your course folder.


